
12.481
Week 1: ArcPad and Windows CE handheld computers

Goals:

• Learn to navigate around the PocketPC 2002 OS

• Make shapefiles in ArcPad

• Learn to add features and data to a shapefile

• Learn to use the information and hyperlink features to query a shapefile

Install ArcPad

Put your iPAQ computer into the cradle attached to one of the laptop computers.
ActiveSync while automatically set up a connection between the iPAQ and the
laptop. When a dialog box on the computer asks if you would like to set up a
Partnership select ‘No’ and click OK (otherwise, it will attempt to Sync all of your
e-mail, etc.). A dialog box will open which looks much like the ‘My Computer’
window on a PC, except that this window will allow you to explore your iPAQ. We
will return to this window in a later lesson.

Once a connection is established, select the Programs menu on the laptop. Find
the ArcPad 6 menu (it may be a sub-menu of ArcGIS), then find Install ArcPad 6
Application for Windows CE. Select this and ArcPad will begin to install itself.
Say OK to all default options. Once ArcPad has been installed, return to the same
menu and select Install ArcPad Font for Windows CE. Again select the default
options. Now your iPAQ is set up with ArcPad.

You can remove the iPAQ from the cradle for the rest of the exercise.

Battery Power

To conserve battery power while working on this exercise, or when using the iPAQ
at all, it is best to keep the backlight at the lowest usable setting. On the iPAQ,
select the main menu from the Microsoft icon in the upper left hand corner. Near
the bottom of the menu is a folder with a gear drawn on it called Settings. Select
this folder.

You will see three tabs across the bottom of the screen, Personal, System, and
Communications. Select System. Select the Backlight icon and you can adjust the
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brightness sliders to the minimum level of light. Return to the System setting. You
can explore the Memory and Power options to see what other controls you have
over battery usage.

Machine Hangups

Sometimes a Windows CE machine will just freeze. Three main possibilities exist
for overcoming this problem. If you are using an iPAQ with an expansion sleeve,
make sure the sleeve is snug. If the iPAQ has a built in Secure Digital card, release
and replace the card. If these fail, perform a soft reboot using the hole on the
bottom of the iPAQ. Place the stylus in the hole and press gently. The machine will
reboot.

Beginning ArcPad

Now that ArcPad is installed, there should be an icon for starting it in the main
menu. Get the menu from the Microsoft icon and look for the ArcPad program.
Tap the word ArcPad or the icon to start the program. Since you have just loaded
ArcPad, you will get a dialog box asking you for the ArcPad registration number.
This number will be available to you in class. If you can not be in lab, please e-
mail one of the TAs for the number so that you can complete the exercise. Once
the registration is completed, ArcPad will boot up, and you will see a blank screen
topped by two or three toolbars.

If you are familiar with ArcView or ArcGIS, these toolbars will look familiar to
you. From top to bottom, they are called the Main toolbar, the Browse toolbar, and
the Draw toolbar. We will spend the next few weeks learning what all of the tools
available in ArcPad can do. For now, we will generalize and say that the Main
toolbar controls File management and preferences. The Browse toolbar controls
screen display functions, such as zoom, pan, etc., and the Draw toolbar allows
features to be added to the map using drawing tools.

You will also notice two styles of icons on the toolbar. One type consists of
a simple icon. The other consists of an icon, a black vertical line, and a black,
downward facing arrow. The former icon performs a function when clicked. The
latter icon does as well; however, the black arrow represents a drop-down menu of
further choices available from that icon.

Working with Shapefiles

In this section we will learn how to create a shapefile in ArcPad, add data to that
shapefile, and query the shapefile with ArcPad functions.
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Create a folder

The first step is to create a folder to keep our shapefiles and data in. From the main
menu, select the Program folder. Find the file explorer, and start it. Work your
way upwards through the file system until you are at the highest level, My Device.
Now move down into My Documents. Create a new folder by pressing the stylus
on a blank piece of the screen. A window will open with New Folder as an option.
Select this option. When you are asked to name the folder, name it 12-481-1. Click
to look inside this folder; it is empty.

In doing this, the ArcPad program may have hidden itself. In the lower right
hand corner of the screen should be an icon which looks identical to the ArcPad
icon in the main menu. Select this icon and ArcPad will be brought to the screen.

Create a new shapefile

On the topmost (Main) toolbar, on the left hand side is an icon that looks like a
folder. Select the arrow next to the folder to reveal a drop-down menu. Among the
options you will see are Open Map, Open Layer, New Map, New Layer, Save Map,
etc. This menu is much like the File menu on a regular PC. From this menu select
the New Layer option.

A new dialog box will open entitled New Shapefile. A pulldown menu at the
top labeled Type will contain the word Point. Many other options are available in
this menu. At the bottom of this dialog box are 5 buttons marked with a grayed out
X, a plus (+) sign, Import..., OK and Cancel.

We will first make a Point shapefile, so set Type to Point. Now we need to add
fields in which to record our data. The + button adds new fields. We will add 4
fields to this particular shapefile, strike, dip, label, and filename. To add the first
field, click the + button. A new menu will open entitled Field. First, input the Field
name, in this case STRIKE. Since STRIKE is a number, the field type should be
changed to Numeric. The length of 10 is adequate for a Strike measurement. Click
OK. Now add three more fields as follows:
DIP — Numeric — 10
LABEL — Text — 10
FILENAME — Text — 50

Then Click OK on the New Shapefile box. You will be prompted to save the
new shapefile. Make sure that location is set to Main Memory. Select 12-481-1,
the folder we created, from the folder list, and type in the name Point in the file
name box. The File type should be either .shp or .apl; either one is fine.

Repeat the exact same process with the following changes: Select Polyline
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instead of Point from the Type menu of the New Shapefile box. Add only one field
to the shapefile:
LINETYPE — Text — 20
and save the shapefile as Line in the 12-481-1 folder.

Now you have two shapefiles created, one for point data and one for line data.
Once these files are created, they are saved. Now we are going to quit ArcPad and
restart so we can learn how to add existing shapefiles to an ArcPad map. From the
File menu select quit. Now go to the main menu and start ArcPad again.

Once ArcPad is up and running, click the second button from the left on the
Main toolbar, the AddLayer button, it is a black + sign on a yellow diamond. A
dialog box will open which resembles in some ways the Windows Explorer on the
PC. Navigate to the 12-481-1 folder and open it up pressing the + button next to
it. In this folder you should see your Point.shp and Line.shp files. Tap the box
next to each to check that you wish to load it. Press OK on the dialog box. These
two shapefiles should now be loaded. To check this, press the Layers button on
the Main toolbar, it looks like 3 yellow sheets of paper. This box shows all loaded
layers. Point and Line, along with GPSTrackLog, should be present. If the check
boxes under the pencil aren’t checked, check these for Point and Line. This makes
the layers editable. Dismiss this box with either Cancel or OK.

So that you don’t have to load these two shapefiles every time you start ArcPad,
you can make a map, which is a file that saves the list of all open Layers, and opens
them each time you open the map. To make the map, return to the File drop-down
menu. Choose Save Map As... A save dialog identical to the one you saw for the
shapefile will appear, except that the file type will now be an ArcPad document, or
.apm file. Call this file Week1 and save it in the 12-481-1 folder. If you are familiar
with ArcView, the .apm file is much like a Project (.apr) file; it contains no data
itself, but keep track of the shapefiles, images, etc, you have open in ArcPad.

Adding point data to the Point shapefile

Now that we have saved the map, we will add data to the shapefiles. In the Draw
toolbar, the third button from the left should be a blue dot. If it is not, activate the
drop-down menu for this button. There should be 4 available options, Point, Line,
Polyline, and Freehand Line. Other options, which are for areal features, such
as polygons and rectangles, are grayed out. This is because we have no editable
Polygon shapefile. Set this icon to Point mode, so that the blue dot is visible on the
toolbar. Press the blue dot. Note that is stays depressed.

To add a point feature to the shapefile, tap the stylus anywhere on the screen. A
dot should appear. A dialog box will also appear that contains a list of the 4 fields
we added to the point shapefile. Press the stylus to the right of the word STRIKE,
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and you will activate a text box. You can now enter a value for STRIKE. Repeat
for DIP and LABEL. We will return to FILENAME later. One bug in ArcPad, is
that you must deactivate the editing feature of a field before closing the text box
for the data to be recorded. After filling in the LABEL, tap the stylus elsewhere in
the dialog box. Now you can click OK to close the box.

Now return to the Layers menu, from the 3 yellow sheets of paper. Double
click on Point.shp. The Feature Properties box will open, with multiple pages. We
will concern ourselves with Labels and Point Style for now. First, move to the
Point Style tab. This is fairly self explanatory. Here, you can change the size,
color, fill, and outline of the points drawn in Point.shp. Do whatever makes you
happy. Checking Make Global Default will save this information and apply is to
subsequent shapefiles.

Now move to the Labels tab. This tab is more complicated. By checking ‘Label
features in this Layer’, many options become available. The first is Field, which is
a drop down menu. Change field to DIP. Click the red letter A and select Tahoma.
Change the font size to 10. Click OK to close this window. Close the Layers
window with the X button in the upper right hand corner. Now, on your map, your
point should be labelled with the value you put in the DIP field. You can return
to the Layers window and change the Label Field to LABEL, to label the points
with this attribute. You may add more points, if you so desire, filling in the field
information as you go. We will learn to edit existing points later in this exercise.

Adding line data to the Line shapefile

Now that we have added point data, we will add line data to our map. ArcPad is
smart enough to add point data to point shapefiles, and line data to line shapefiles.
With only one of each on this map, this is a pretty easy scenario. If you had multiple
point or line shapefiles that you wished to add data to, you would need to open the
Layers window and make editable, by placing a check under the ‘pencil’, the layer
you wished to add data to.

Now, from the drawing tools icon, get the drop down menu and select one of
the line drawing tools; it doesn’t matter which one, but Freehand line is easy to
use. Once this is selected, you can draw on the map with your stylus and create a
line. When you lift your stylus an attribute box opens, just like with the point. You
can add data in the same manner, typing a LINETYPE into the edit field.

Just like with points, you can also change Line Properties from the Layers
window by double clicking on Lines.shp. The Label tab works just as it did for
points. The Line Properties is much like the Point Properties, except that you can
change line color, width, and dash characteristics. Play around with these, then
click OK and close the Layers window. Whatever changes you made to the Line
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Properties should appear.

Querying the shapefiles

The last things that we will learn how to do are query, edit, and hyperlink data. In
this section we will learn to use the Info tool to query data. First open the Layers
dialog box again. Note that to the right of each shapefile there are two checkboxes,
one under a circled I the other under a pencil. The pencil check box determines if
the layer can be edited. The I checkbox controls whether or not data in that layer
can be queried. Be sure that the I box is checked for both Point and Line shapefiles.

Close the Layers window and return to the map. The middle button on the
Browse toolbar should look just like the icon you saw in the Layers window, a
white I in a blue circle. Click this button. Now place the stylus on top of any line
or point and click on it. A window will open with all of the attributes of that current
feature. Try this with points and lines.

Now choose a final point to work with. From the Draw toolbar, click on the
select arrow, on the far left. With this arrow selected, click on the point with the
stylus. A dashed box will be drawn around the point, indicating that it is selected.
Now click on the Properties icon, on the far right of the Draw toolbar (it looks like
a hand with a piece of paper). A box will open that looks much like the box that
appeared with the Info tool. Notice, however, that you can edit field values in this
window. Change a DIP or STRIKE value. Now go to FILENAME, which should
be blank and add the value ‘file1.psw’ to the FILENAME field. Click OK. Use the
Info tool to make sure that this data was recorded properly. The final task for today
is setting up a hyperlink. To do this, we will first need to leave ArcPad. Instead of
quitting ArcPad, this time, press the X icon in the lower right corner of the screen
to minimize ArcPad.

Now we’ll move on to set up a hyperlink.

Setting up a hyperlink

A hyperlink allows you to link from ArcPad to a file or program that is external to
ArcPad. In this example, we will set up a hypelink to a PocketWord document.

With ArcPad minimized, go to the main menu. If Word is not visible in the
menu, open the Programs folder. Tap Word in this folder to start it. If it asks, open
a Blank Document, or tap New in the lower left hand corner. Type anything you
wish in this document. Use the Format tools under the Edit menu to make bold
or italic text. When you are finished creating a document, choose Save Document
As... from the Tools menu at the bottom of the screen. The name of the document
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should be file1, the type should be PocketWord, which will automatically append
.psw. Select 12-481-1 for the folder, and click OK to save.

Return to ArcPad by clicking the ArcPad icon in the lower right corner of the
screen. Open the Layers window and double click on Points.shp to get the Prop-
erties window. Use the arrows at the upper right to move right through the pages,
past Point Properties to Hyperlink. This page contains just a single dropdown
menu. From this menu select FILENAME and close the window with OK. Then
close the Layers window.

Get the dropdown menu next to the Info icon. Near the bottom is an icon
which looks like a lightning bolt. This is the hyperlink icon. With the hyperlink
icon selected, return to the point you edited earlier and added a filename to. Click
on this point with the stylus. The PocketWord document you created should now
appear on the screen.
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